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New Project Screen 9

/aSPACX. La SPAC E

* On starting Project a blank template will appear.

& Microsoft Project - Project1 |Z||E|fg|
@ File Edit Yiew Insert Format Tools Project Window Help ﬂﬂ
DEHSRY $2BC © @ =i B ¢ @ oo eey e,
& B & = Show~ | Aral +8 - B I U == =|alTasks v T= N L
a Task Mame Duration Jul 15, '04 Jul 25 '04 Aug 1,04 Aug 5 04 Aug 15, '04 Aug 22 '04 Aug29,'04 A
wWT[F[s[sMITw[T[F[s[sM[Tw[T[F[s[sm[TW[T[F[s S|M|T|W|T|F|S sm[Tw[T[F[s S|M|T|W|T|F|S S|M|T|W|

k) KI Ja | K | ﬁ
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LaSPACY.

* From the “Project” menu select “Project
Information” and enter the anticipated project start
date.

Project Information for ‘Project1’

Start date: m

Finish date: |Man 7j26/04

KA NERNNERN )

Schedule From: |F'r|:|ject Start Date

&ll kasks begin as soon as possible,

Current dake: |M|:|r| 7lzai04

ENQEERED

Status date: |N.ﬁ.
Calendar: | Standard
Priority: ETl=
Help | 5tati_5tin:5...| (K Cancel |
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0> Enter the major tasks

o
07 s\

* Type in the major tasks (WBS level 1) in the “Task Name™ box.
e Each row is a separate task

* Do not worry about the rest of the columns for now

-& Microsoft Project - Project1

=1
Eﬂ File Edit WYiew Insert Format Tools Project Window Help ﬂﬂ
= & - @ .
Show = - - = 5
¥ || Data Archive U
(5 ] Task Mame Duration Start Finizh Predecessars (R 5, '05 Jan 23, '05 Jan 30, '05 Feb B '05 -
T|wlT[F[s [wTlF[ssm[T wlT]F[s]|s|M[T w]T[F =
Povver System 1day? Mon 172405  Mon 152405
2 Flight Contral Unit 1day? Mon 172405  Mon 1/24/05

|Da1a Archive U

]

f D el
4]

< el | fl

MUM
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Insert Rows

A
7, et
e, Qe
Vnoy g 1W?

LaSPACY.

« Select the row above which you want to insert a subunit
* Seclect “New Task” from the “Insert” menu
« To delete a row, select the row and press the “Delete” key

Ej File Edit Yiew Insert Format Tools Project ‘Window Help ﬂﬂ
NEEHSRY 2R @ =i B ¢ & weop Ao
€ & & = show- | Al 8 - B IO EE=E = AlTasks - Tz
[i] Task Mame D ation Start Finizh Predecessors R Jan 23 '05 Jan 30, '05 Feb B, '05 Fi
SMITwWITIF[s[sM[Tw[T[F[s|[s[M|TW[T[F]s s:
1 Powver System 1 day?| Mon 152405 Mon 1724705
2
= 3
L 4
5
5]
!
g Flight Coritral Uit 1 day?| Mon 12405 MWon 172403
g Diata Archive Unit 1 day?| Mon 1524005 Mon 1/24/05
10 Diata Archive Disk 1 day?| hon 12405  won 1/24/05
11 A pxiliary Transmitter 1 day?| Mon 12405  MWon 1/2405
12 Mechanical Structure 1 day?  Mon 12405 Mon 172405
13 Thermal Control 1 day?| Mon 152405 Mon 1/2405
— 14 System Integration & Test 1 day?| hon 12405  Mon 1/2405
iRl 15 Management 1 day?| Mon 122405 MWon 1/2403
£ AN mli ﬁ
Ready UM
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Enter the subunit task names
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”701 3“(«30

LaSPACY.

» Type in the name of the subunit task in the “Task Name™ field
* Subunits are “indented” with the right arrow on the task bar

*  When subunits are so “indented” the major unit will become bold and the
Gantt chart bar will change shape

@ File Edit Wew Insert Format Tools Project wWindow Help ﬂﬂ
DEeE GRY BB v @ e B e @ oo - R @ (3,
@ B & = show~ | Arial 5 « B I U == = AlTasks o] T | =S
Inktegrate & Test
i) Task Mame Duration Start Finizh Predecessors  |Ra Jan 23 '05 Jan 30, '05 Feb B, '05 Fral
ST WTF ]S |5 M Ww]TF ]SS M|T WTIF5|S
1 [= Power System 1day? Mon 12405 Mon 1/24/05 vy e
2 Povver Source 1 day?  Mon 102405 Mon 152405
= 3 FCU Supgly 1 day?  Mon 152405 Mon 102405
- 4 DALl HD Supply 1 day?  Mon 152405 Mon 142405
£ DAl Supply 1 day?  Mon 1024035 Mon 152405
] CubeSat Supply 1 day?  Mon 102405 Mon 152405
7 { Integrate & Test | 1 day?| Mon 12405 Mon 1/24/05
g Flight Cortrol Unit 1 day?  Mon 102405 Mon 1524005
g Data Archive Unit 1 day?  Mon 102405 Mon 152405
10 Diata Archive Disk 1day?  Maon 152405 Mon 152405
11 Auxiliary Transmiter 1 day?  Mon 1024005 Mon 142405
12 Mechanical Structure 1 day?  Mon 102405 Mon 152405
13 Thertnal Caontrol 1day?  Maon 152405 Mon 152405
— 14 System Integration & Test 1 day? MWon 152405 Mon 142405
—
TT= 1a hanagement 1 day? Mon 12405 Mon 152405
-
&) KT HO = »
Ready UM
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- Complete entering WBS

LaSPACY.

e Process of inserting rows, typing in the task name and indenting the
subunit continues until all tasks in the WBS are entered

‘& Microsoft Project - Project1

@ File Edit “ew Insert Format Tools Project ‘Window Help ﬂﬂ
D E Sy & RBRC v @ =i B < &) oo | REA T @ ().
€ & + = show- | Ardl -8 | B I U === alTasks v T= | SN
[i] Task Mame Duration Start Finizh Predecessors  |R [Jan 23, '05 Jan 30, '05 Feh B '05 &
SM[TIw[T[F[s|sMITIwW[T[F[S|S[M]T |w
1 =| Power System 1day? Mon1/2405 Mon 124105 L o
2 Powver Source 1 dday?  Mon 12405 Mon 102405
3 FCU Supply 1day?  Won 1024005 Mon 152405
4 DAL HD Supply 1 day?  Mon /2405 Mon 1724005
51 DAl Supply 1 day?  Mon /2405 Mon 1724005
E =| CubeSat Supply 1day? Mon 12405 Mon 12405
7 Interface to power source 1day?| bon 1724105 Won 152405
g =l FCU Control Interface 1day? Mon1/2405 Mon 124105
9 Establizh Control Requirements 1 day?  Mon1/2405  hon 102405
10 Design control interface 1day?  Won 102405 Mon 152405
11 Prototype & test design 1day?  Mon 102405 Mon 152405
12 Complete design 1day?  Mon 1024005 Mon 102405
13 Implement & test design 1day?  Mon 12405 Mon 102405
A 14 DCDC Converters 1day?  Won 1024105 Mon 152405
i 13 FCU Monitoring Interface 1day?  Mon1/2405  Mon 172405
16 Integrate & Test 1 day?  Mon /2405 Mon 1724005
17 Flight Contral Unit 1aay?  Mon 102405 Mon 152405
15 Diata Archive Unit 1day?  Won 152405 Mon 152405
m 18 Data Archive Disk 1day?  Mon 1024005 Mon 102405
20 Auziliary Transmitter 1 day?  Mon 102405 hon 102405
2 Mechanical Structure 1day?  Won 102405 Mon 152405
22 Thermal Caontrol 1day?  Mon 102405 Mon 152405
23 System Integration & Test 1day?  Mon 1024005 Mon 102405
24 Management 1day?  Mon 12405 Mon 102405 =
| i
Emlha| KN ;IZl
Ready LM
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Display the WBS code

* Select the “Information” column, right click and choose “Hide
Column”.

* Next select the “Task Name” column and from the “Insert” menu
select “Column”. The following pop-up will appear.

* Choose “WBS” as the “Field name”

LaSPACY.

Column Definition

Field name: - oK
_ WAL -

Title: Cancel
~ |'"WBS Predecessors .
Align title: yuee o) crassars Biest Fit

hae wW'ork
Al e Work Conkour I
width: WDrlk‘Earianil -

LSU rev20220228 L24.02 MS Project Example 8



Showing the WBS code

[dSPAQ&

e The correct WBS code number will now be displayed for all
tasks

& Microsoft Project - Project1

@ File Edit W¥iew Insert Format Tools Project Window Help
DEE SRY {B2RY «» @ =i B ¢ @ Neoup F|RaF @B,
@ P & = show~- Aral -8 - All Tasks
1
WBS Task Mame Duration Start Finizh Jan 23, '05 Jan 30, '05 Feb £, '05 F a
515 M[TIWITF s[5 M[TWITIF|S[sMIT WITIF[S sj

1 1|= Power System 1day? | Mon 172305 Mon 1723105 vy

2 |:11! Powver Source 1day? Mon /2405  Mon 1724005

g 1.2 FCU Supply 1day? Mon /2405  Mon 1724005

4 1.3 DAL HD Supply 1day? Mon1/24/05  Mon 1724005

3 1.4 DAL Supply 1 day? Mon1/24/05  Mon 1724005

B 1.5 [=] CubeSat Supply 1 day? | Mon 12405 Mon 1/2405

7 1.51 Interface to povwer source 1 day? Mon /2405  Mon 1724005

g 1.5.2 =l FCU Control Interface 1 day? | Mon 1/2405 Mon 12405

9 15241 Establish Cortrol Requirements 1 day? Mon /2405 Mon 1724005

10 1522 Design contral interface 1day? Mon /2405  Mon 1724005

1 1523 Prototype & test design 1day? Mon /2405  Mon 1724005

12 1524 Complete design 1day? Mon1/24/05  Mon 1724005

13 15258 Implement & test design 1 day? Mon1/24/05  Mon 1724005

14 153 DCDC Converters 1 day? Mon /24005  Mon 1724005

15 154 FiCU Monitoring Interface 1 day? Mon /2405  Mon 1724005

16 1.6 Integrate & Test 1 day? Mon1/24/05  Mon 1724005

17 2 Flight Control Unit 1day? Mon /2405 Mon 1724005

18 3 Drata Archive Unit 1day? Mon /2405  Mon 1724005
m 19 4 Drata Archive Disk 1day? Mon /2405  Mon 1724005

20 5 Auxiliary Transmitter 1day? Mon1/24/05  Mon 1724005

2 B Mechanical Structure 1 day? Mon1/24/05  Mon 1724005

22 7 Thermal Contral 1 day? Mon /24005  Mon 1724005

23 g System Integration & Test 1 day? Mon /2405  Mon 1724005

24 9 Management 1 day? Mon1/24/05  Mon 1724005 =
il | 3| TR ﬁ
Ready UM
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Task bars

LaSPACY.

»  With all subunits inserted the lowest level will be blue rectangles and
higher levels will be black bars with points on the ends.

@ File Edit W¥iew Insert Format Tools Project Wwindow Help ﬂﬁ
DeE SRV {BRY © @ =8 B ¢ @ Moo - R w3,
4 % & = show- | Arial -5 - |B I O = | allTasks - T
Power Source
WHBS Taszk Mame Duration Start Finish Jan 23, '05 Jan 30, '05 Feb B, '05 Fﬂ
S| sMIT w[T[F[s[sM[TW[T[F[s|s[M T[w[T[F[S]s
2 11| [# Power Source | 1day? Mon1/2405 Mon 172405 vy J
4 1.2 [# FCU Supply 1day?  Mon1/23/05 Mon 1/24/05 vy
3 1.3 [+ DAU HD Supply 1day? Mon1/2405 Mon 1/24/05 y
a 1.4 [# DAU Supply 1day? Mon1/2405 Mon 1/24/05 vy
10 15 [ CubeSat Supply 1day?  Mon 1723105 Mon 1/24105 vy
11 1.5.1 [+ Interface to power source 1day? Mon 1/24/05 Mon 1/24/05 ey
13 1.5.2 =1 FCU Control Interface 1day? | Mon 12405 Mon 1724105 vy
14 15241 Esztablizh Control Reguirements 1 day?  Mon 124005 Mon 172405
15 1522 Design control interface 1dlay?  Mon 124035 Mon 12405
16 1523 Prototype & test design 1day? Mon 102405 Mon 172405
17 1524 Complete design 1 day?  Mon 12405 Mon 12405
18 1525 Implement & test design 1day? Mon 102405 Mon 172405
19 153 [# DC/DC Converters 1day? Mon 1/24/05 Mon 1/24/05 L o
21 154 [¥ FCU Monitoring Interface 1day? | Mon 12405 Mon 172405 L o
23 1.6 [+ Integrate & Test 1day? Mon 1/24/05 Mon 1/24/05 L o
23 2 [+ Flight Control Unit 1day? | Mon 12405 Mon 1724105 L o
27 3 [+ Data Archive Unit 1day? | Mon 12405 Mon 1/24105 vy
29 4 [ Data Archive Disk 1day? Mon 12405 Mon 1/24/05 -
m ki 5 [+ Auxiliary Transmitter 1day? Mon 12405 Mon 1/24/05 vy
33 6 [ Mechanical Structure 1day? Mon 12405 Mon 1/24/05 L o
35 7 [+ Thermal Control 1day? Mon1/24/05 Mon 124105 L o
37 8 Sy=stem Integration & Test 1day? | Mon 1/2405 Mon 1/24/05 .y
39 9 |[# Management 1day? Mon 12405 Mon 12405 vy
T
e | KT | ﬁ
Ready UM
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LaSPACY.

* You can change the color of the task bar to distinguish between the
different levels in your WBS

« Select the task bar to change (in the Gantt chart area), right click and
select “Format Bar”.

« Change the color of the “Start”, “Middle” and “End”
| Format Bar @@

Bar Shape ] Bar Text l

Skart Middle End

Shape: | v - Shape: | j Shape: v "l
Tvpe: |S|:|Ii|:| - Pattern: |_j Type: Solid vl
Color: |. Black. - Color: { Zolor: . BElack, Tl

Sample:

B Red
O vellow
FD Lirre:
[ Aqua
B clu=
B Fuchsia

Help | [] white QK | Cancel

B Maroon
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@ File Edit View Insert Format Tools Project Window Help ﬂﬂ
Dzl alky saRd @ =i B ¢ B NoGow R T | @ E.
& & + = show~ | Al -8 - B I U = = | Al Tasks - V= | L
WWHS Task Mame Driration Start Finish Jan 23 '05 Jan 30, '05 Feb 6,'05 Fa
slsMlTiwlr[Fs[sMTw[T[F[s[sMITw[T[F[s sj
1 1 = Power System 1day? Mon 12405 Mon 1/24/05 -
2 141 [ Power Source 1day? Mon 172405 Mon 12405 [
4 1.2 FCU Supply 1day? Mon 12405 Mon 12405 =
3 13 [# DAUHD Supply 1day? Mon 12405 Mon 124105 (=]
g 1.4 [+ DAU Supply 1 day? Mon 12405 Mon 1/2405 =
10 1.5 [=l CubeSat Supply 1 day? Mon 12405 Mon 123105 =7
11 151 [+ Interface to power source 1day? Mon 12405 Mon 12405
13 1.5.2 [=| FCU Control Interface 1 day? Mon 1/24/05 Mon 1/24105
14 1521 Establizh Control Reguirements 1 day?| Won 1724005 bon 172403
15 1522 Design control interface 1 day?| Mon 12405 Mon 12403
16 1523 Prototype & test design 1 day?| Mon 152405 won 172403
17 1524 Complete design 1 day?| Mon 12405 Mon /2405
16 1525 Implement & test design 1 day?| Mon 152405 non 172405
19 1.5.3 [+ DC/DC Converters 1 day? Mon 1/2305 Mon 1/24/05
21 154 [+ FCU Monitoring Interface 1 day? Mon 12405 Mon 124105
23 1.6 [# Integrate & Test 1 day? Mon 12405 Mon 1/24/05 o
25 2 |[# Flight Control Unit 1 day? Mon 1/24/05 Mon 1/24105 -y
27 3 [ Data Archive Unit 1day? Mon 172405 Mon 12405 .y
m 29 4 [+ Data Archive Disk 1day? Mon 12405 Mon 12405 -y
ol 5 [+ Auxiliary Transmitter 1 day? Mon 1/24/05 Mon 1/24/05 vy
33 6 [+ Mechanical Structure 1day? Mon 123105 Mon 12405 L o
33 7 [# Thermal Control 1day? Mon 1723105 Mon 1/24/05 v
37 ] Systemn Integration & Test 1 day? Mon 1/2305 Mon 1/24/05 L o )
39 9 Management 1 day? Mon 12405 Mon 124105 v o
ol | : sl i
Ready M

LSU rev20220228
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LaSPACY.

" Set the task durations

 Now enter the time associated with each task in the “Duration” field.
See the MS Project Help for choices on units.

* Set durations for the lowest level tasks and the total time will be
summarized or rolled-up to the next highest level.

& Microsoft Project - Example Project.mpp

File Edit View Insert Format Tools Project Window Help ﬂﬂ
DEE SRAY iBEaT v @ =% B ¢ @ Neru - REF @,
@ % + = chow~ Al -8 - ||B I U == = AlTasks Rl
System Integration & Test
WBS Task Name Durstion Start Finish Predecessors  |Re Jan 23, '05 Jan 30, '05 Feh &, '05 Feh13,'05 ~
s[sM[T[wW[T[F s [SM[TW][T[F[s[S[M][T W][T]F]S s'lmj
1 1 = Power System 10 days Mon 12405 Fri 2/3/05 L . w
2 11 =+ Power Source 5days Mon 172405 Fri 128105 PE——
e 4 1.2 =+ FCU Supply 10 days Mon 12405 Fri 2305 L . v
=t ] 1.3 =+ DAU HD Supply 5days Mon 172405 Fri 128105 P—
& 14 =+ DAU Supply 10 days Mon 12405 Fri 23105 L . v
10 1.5 =l CubeSat Supply 4days Mon 124005 Thu 127105 p——
11 1.5.1 + Interface to power source 2days Mon1/24/05 Tue 1/25/05
13 152 =l FCU Control Interface 4days Mon 124105 Thu 1227105
14 1521 Establish Control Requirements 1day  Mon 102405 Mon 1/24/05 BE
15 1522 Design control interface 2days Mon 172405 Tue 1/25/05
16 1523 Prototype & test design ddays  Mon 172405 Thu1/27/05
17 1524 Complete design 1day Mon 172405 Mon1/24105
18 1525 Implement & test design 2days  Mon /2405 Tue 1/25/05
— 18 153 # DC/DC Converters 3days Mon 124005 Wed 1/26/05
pa 15.4 # FCU Monitoring Interface 3days Mon 1/24005 Wed 1/26/05
23 1.6 + Integrate & Test 3days Mon 124005 Wed 1/26/05 o—
25 2 [+ Flight Control Unit 10 days Mon 1/24/05 Fri 24105 L .
27 3 [+ Data Archive Unit 10 days  Mon 1/24/05 Fri 24105 L ]
m 29 4 [+ Data Archive Disk 3days Mon 124005 Wed 1/26/05 p——
l 5 [+ Auxiliary Transmitter 5 days Mon 1/24105 Fri 1/28/05 PE——
33 6 [+ Mechanical Structure 10 days Mon 12305 Fri 2/4/05 L . w
35 T # Thermal Control 5days Mon 12405 Fri128/05 P—
37 8| System Integration & Test | 6days Mon12405 Mon 13105 v v
39 9 + Management 50 days Mon 12405 Fri 41/05 L -
et KN i o
Ready MM

LSU rev20220228
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Set the task predecessors

LaSPACY.

* Enter the task dependence (i.e. which tasks must be complete prior to starting
the next task) in the “Predecessors” field.

* You need to use the row number, not the WBS code.

& Microsoft Project - Example Project.mpp

@ File Edit ‘iew Insert Format Tools Project Window Help ﬂﬂ
DelE SRY $BES o @ =i B ¢ & Mo - Re T @3,
4 B & = Show~- | Arial -85 - || B T U|=E=E = alTasks - =L
WS Task Mamne Duration Start Finizh Predecessors | Re Jan 23, '05 Jan 30, '05 Feb 6, '0 &«
F 1|5 M[T [T F[5 5 M[T[W[TIF[s |5 MIT
1 1 =/ Power System 10 days | Mon 1/24/05 Fri 2/3/05 . y
2 14 + Power Source 5days Mon 1/24/05 Fri 1/28/05 7
= 4 12 # FCU Supply 10 days Mon 1/24/05 Fri 2/4/05 5 y
- -] 13 + DAU HD Supply 5days Mon 12405 Fri 1/28/05 PE—————
] 1.4 +] DAU Supply 10 days Mon 1/24/05 Fri 2/4/05 P v
10 15 =] CubeSat Supply 10 days Mon 1/24/05 Fri 2/4/05 v 7
11 151 4 Interface to power source 2days Mon1/2405 Tue 1/25/05
13 1.5.2 =| FCU Control Interface 10 days  Mon 1/24/05 Fri 2/4/05
14 1.5.21 Establish Control Requirsments Aclay | Mon 12403 Mon 172405
15 1522 Design cortrol interface Zoays | Tus 12505 Wed 12605 14
18 1523 Prototype & test desion 4 days|  Thu 12703 Tue 2A4035 15
17 1524 Complete design Aday  Wed 2i203  Wed 20203 16
18 15235 Implement & test design 2 days Thu 2131035 Fri2i4i0a 17
— 13 153 % DC/DC Converters 3days Mon 12405 Wed 12605 :l
liZhe 21 154 + FCU Monitoring Interface Jdays Mon12405 Wed 1/26/05 i
23 1.6 + Integrate & Test Jdays Mon12405 Wed 1/26/05 L—
23 2 | [+ Flight Control Unit 10 days  Mon 124/05 Fri 2/405 L v
27 3 |+ Data Archive Unit 10 days  Mon 12405 Fri 2/405 L . 4
m 29 4| [+ Data Archive Disk Jdays Mon12405 Wed 1726/05 p—
il 5 [ Auxiliary Transmitter 5days Mon 1/24/05 Fri 1/28/05 PE——
33 6 =/ Mechanical Structure 10 days Mon 172405 Fri 2/3/05 L . y
335 T I Thermal Control 5days Mon 12405 Fri 1/28/05 P
37 8 [ System Integration & Test Gdays Mon 12405 Mon 1/31/05 P
39 9 [l Management 50 days | Mon 1/24/05 Fri 41105 L
=
=il 3 |RY f‘

Ready

LSU rev20220228 L24.02 MS Project Example 14
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LaSPACY.

Enter all predecessors

Here all the task predecessors are determined and entered, but
the Gantt chart now needs room to display fully

Microsoft Project - Example Project.mpp
@ File Edit Yiew Insert Format Tools Project Window Help
D SRY 2R | = E & € | Modrow - R/RaF @,
4@ % & = show~ | Aral -3 -|lB I U = All Tasks - T L
Flight Cantral Uit
Taszk Mame Duration Start Finizh Predecessors | Resource 227,'05 Mar B, '05 Mar 13 '05 Mar 20, '05 ar 27, '05 Apr 305 -
M T P T[F S [SM[T WITF[S[S[M[TWIT[F[S[S[M[TMWI[TIF[S[S[M[TWI[T[F[s|S[M|[TW[TIF]S
1 =] Power System 51 days Mon 12405 Mon 4405 v
2 ¥ Power Source 5days Mon 1/24/05 Fri1/28/05
4 [+ FCU Supply 10 days Mon 1/31/05  Fri 241/05
3 [ DAU HD Supply 5days | Mon 244105 Fri218/05
g [+ DAU Supply 10 days  Mon 272105 Fri 3/4/05 ——
10 [ CubeSat Supply 18 days Mon 37705 Wed 3/30/05 P P
1 [+ Interface to power source 2days Mon 3705  Tue 3/3/05
& El FCu Control Interface 10 days Wed 3/9/05 Tue 32205
14 Esztablish Control Requirements Aday  Wed 30905 Wed 359005 12
15 Design cortrol interface Zdays | Thu 3005 Fri3m1i0s 14
16 Prototype & test desion 4days| Mon3M405 Thu3M705 15
17 Complete design 1 day Fri 3181035 Fri3MB0s5 16
18 Implement & test design 2days| Mon 32105 Tue 322035 17
19 [#/ DC/DC Converters Jdays Wed 3/23/05 Fri 3/25/05
21 [# FCU Monitoring Interface Jdays Mon 3728005 Wed 3/30/05
[# Integrate & Test 3days Thu3/31/05 Mon 4405 L -
ight Control Unit | 10 days  Mon 214705 Fri 2/25/05
Data Archive Unit 10 days | Mon 37705 Fri 318/05 W y
m Data Archive Disk Jdays Mon 32105 Wed 3/23/05 Pp——
31| ¥ Auxiliary Transmitter Sdays Thu 32405 Wed 3/30/05 P
33 |+ Mechanical Structure 10 days Tue 4505 Mon 413/05 P
35 Thermal Control Sdays Tue 419/05 Mon 4/25/05
37 System Integration & Test 6 days Tue 426/05 Tue 5/3/05
39 | [ Management 100 days Mon 1/24/05 Fri 610/05 =
Egpke] K| u 1 |KT H ;III
Ready

LSU rev20220228
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LaSPACY.

Set the timescale of the chart

 From the “Format” menu select “Timescale”
* Set the Major Scale to Months
e Set the Minor Scale to Weeks

j ¥ Use Fiscal Year

I Morworking Time ]
Label: | January
align: Left - W Tick lines
Label: |SJMJT,.“
Align: Center = ¥ Tick lines

W scale separator

j ¥ Use Fiscal Year

[s[sIm[Tw]T]F[s[s[m[TwlT[F[s]s[Mm[T [T [F[s]sS

Timescale l Monwarking Time Timescale
Major scale Major scale
nits: Label: |Jan 30, '00 j W Use Fiscal Year Uriits: Months -
‘fears = ’——| ST -
; : Left v v Tick lines A -
Count Half Years Align VT Count :l
Minor scale| Quarters Minor scale
Months "
its: [ W Lz Fiscal Year its:
Units Thirds of Manths Label S M, T, j I e Units
Count: | Wesks align: Center v ¥ Tick lines Count; | Tears
Days Half Vears
General | Hours General —| Quarkers
Sizg;  [Minutes ¥ sScale separator Sizgy  |Months
- L — - Thirds of Maonths
Preview Preview
Days
15 Feh 27,'05 Mar & '05 War 1.3, '05 har 20, '05 ] Hours
wi T [Fls(sMTw[T[Fls|sm[Tw[T[Fls|sM[TIw[T[Fls[s[M[TIw[T[F[s]s] whwmmm
one
o4 | Cancel |

Cancel

[oc |

LSU rev20220228
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" After timescale change 3

S
ZaSPACR.

* Now the full Gantt chart from project start to end can be displayed

Microsoft Project - Example Project.mpp

@ File Edit Wiew Insert Format Tools Project Window Help

DEESRAY {BRd @R == e E @ & | NoGroup - RAT | @ 3.

4@ P & = show- | Al +5 ~||B I U Al Tasks - Tz AL

Management
Task Mame Duration Start Finizh Pred | February | March | Aparil 0] -
MG [ 123 (130 | 206 | 2M3 | 2020 | 2027 | 36 | 3M3 | 320 | 3027 | 453 |40 (47 44 ﬁLl_sj
1 | Power System 51days Mon1/2405 Mon 4/4/05
2 [+ Power Source 5days  Mon 12405  Fri1/28/05 [—
4 10 days | Mon 1/31/05 Fri 2M1/05 L
G 5 days | Mon 2/14/05 Fri 218/05 gy
g [+ DAU Supply 10 days | Mon 2/21/05 Fri 3/4105 L—7
10 [=] CubeSat Supply 18 days Mon 3705 Wed 3/30/05 ]
11 [# Interface to power source 2days | Mon3/7/05  Tue 3/8/05
13 [=l FCU Control Interface 10 days | Wed 31905 Tue 3/22/05
14 Establizh Control Recuirements 1day  Wed 3805 Wed 3805 12
13 Design control interface 2days  Thu 3M0M05 Fri3M1/05 14
16 Prototype & test design 4days  Mon 31405 Thu 3705 135
17 Complete design 1 day Fri 3M8/05 Fri 3M8/05 16
18 Implement & test design Zdays  Mon 32105 Tue 3522105 17
19 [+ DC/DC Converters 3 days Wed 3/23/05 Fri 3/25/05
2 [+ FCU Monitoring Interface 3 days | Mon 3/28/05 Wed 3/30/05 |
23 [# Integrate & Test 3days | Thu3/3105 Mon 44105 H
25 |[# Flight Control Unit 10 days | Mon 211405 Fri 2/25/05 P
27 Data Archive Unit 10 days | Mon 3/T05 Fri 318105 P
m 253 [+ Data Archive Disk 3days  Mon 32105 Wed 3/23/05 L o
31 [# Auxiliary Transmitter Sdays | Thu 3/24/05 Wed 3/30/05 p—
33 Mechanical Structure 10 days  Tue 4505 Mon 4/18/05 P—
35 Thermal Control Sdays | Tue 419/05 Mon 4/25/05 p—
37 System Integration & Test 6 days Tue 4/26/05 Tue 5/3/05 p——
33 ¥ Management | 75days Mon 12405 Fri 5/6/05 v y
-
=il | ol ﬁ
Ready
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« To make a GIF image that can be inserted into documents, first
arrange the chart and task info boundaries to display just what

you want.

e From the “Edit” menu select “Copy Picture”
« Select “To GIF image file:” and enter a filename for the image

* Select what to copy: Rows

Render image
{~ Far screen
™ For printer
% To GIF image file:
|I|:|urse'l,F‘ru:|ject ManagementiLecture 61Example Project, gif Browse, .,

Copy
% Rows on screen

{ Selecked rows
Timescale

¥ fis shown aon screen

 From:  [Sun 1/9/05 j To: [Sun 5/8/05 j
| (0] 4 | Zancel |
LSU rev20220228

on screen or Selected Rows

Select the timescale as
either what 1s shown on the
screen or for specific dates

Click OK and the image will
be generated.
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Final version of project

S

LaSPACY.

* Below 1s the GIF image of the example project
ready to be inserted in a document.

| February | March [ &gl bz
I | Task Mame 199 [ 1Me [ 13 (1m0 [ 26 [ 23 (220 [ 2ie7 | a3 [ an3 [ 3e0 [3er | am [ an0 [an7 [ 424 [ s | s
1 Power System P
2 Power Source P
4 FCU Supply P
5 DAU HD Supply p—
3 DAL Supply P
10 CubeSat Supply
11 Interface to power source
13 FCU Control Ilterface
14 Establizh Control Requiremerts
15 Deszign contral interface
16 Prototype & test design
17 Complete design
18 Implement & test design
18 DCDC Converters
| FCU Monitoring Interface
23 Integrate & Test L
25 |Flight Control Unit P
27 |Data Archive Unit P
29 |Data Archive Disk L o )
3 | Auxiliary Transmitter u—
33 |Mechanical Structure P
35 | Thermal Control p—
37 | System Integration & Test p—
33 |Management —
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